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Presidentôs Message 
 

I am delighted to report that we have had an excellent 

start to the 2008-9 programme. Thanks go to Mike 

Olney for organising a very successful weekend in North 

Norfolk, and I understand that it was much enjoyed by 

all participants. The photographs which have been 

displayed on the notice-board certainly show a band of 

very happy people. The weather was both bright and 

warm, ensuring „shirt sleeve order‟ and,  I hope,  some 

images taken in favourable light.  In contrast, umbrellas 

were required for the „Points of View‟ Competition in 

Cambridge but it mattered not as this was a splendid 

day. The six interesting subjects allowed some scope of 

interpretation and it will be fascinating to see what 

members come up with. The day ended with a cream tea 

in the Orchard Tea Rooms at Grantchester and, for those 

who were interested, a fascinating browse amongst the 
artefacts in the small Rupert Brooke Museum. Despite 

the weather, it was most enjoyable and thanks must go to 

Tony Joyce for organising it. 

 

So far this season we have had two excellent lectures, 

the first by Ron Tear on wide-ranging subjects from 

aviation to wildlife, and then by Richard Revels on The 

Falklands. 

  

I was pleased that the Open Competition went smoothly, 

and relieved that Club members remembered to submit 

their projected digital images a week before the 
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competition, thereby enabling Diana Moss and her team 

to prepare a seamless presentation of work on the night.  

 

Tony Joyce and Mike Quickenden put in a lot of work in 

preparing material for the Bedford Interclub 

Competition early in November. A total of 13 clubs 

entered, and Cheryl Bethell and her team of helpers 

provided our visitors with mouth-watering cakes and 

drinks during the interval. There were some stunning 

images and at the end of the evening Biggleswade 

Camera Club just pipped Shillington to win the coveted 

trophy. Again, thanks to club members for a good team 

effort in providing a very enjoyable evening‟s 

entertainment. 

 

A recent meeting led by Stan Searle, in which he put us 

into teams to discuss the relative merits of specially 

selected prints, was most successful and much fun. 
Newcomers to the club found it extremely valuable, but 

also welcomed the opportunity to get to know other 

members in the informal surroundings of their small 

group. 

 

I would like to put on record my sincere thanks to one of 

my near neighbours, Ian Whiting, who has been working 

in liaison with Mike Quickenden in giving the Club‟s 

website a thorough overhaul and making it more easily 

accessible.  

 

At the beginning of the new season it was a shock to 

discover that the projector for digital images was 

missing from the locked BCC cupboard in Priory 

Methodist Church. Hopes that it had been borrowed over 

the summer break have now faded; sadly it looks as if it 

has been stolen and will have to be replaced. It is 
something of a mystery as there was no evidence of 

forced entry into the locked cupboard. In future the 

computer and projector will be deposited elsewhere for 

safe-keeping. 

 

I should like to take this opportunity of wishing all 

members and their families a very Happy Christmas and 

New Year. 

 

Vaughan Southgate 

     

Editorial  
 
When digital cameras first came along I naively thought 

that they would make photography much simpler and 

that with the removal of darkrooms, for example, we 

would run short of topics for Camera Club evenings. 

How wrong I was. Digital photography has opened new 

horizons and possibilities. It demands even more 

knowledge than previously of the techniques for taking 

and processing images. Just when I thought I had 

reached a reasonable standard in using Photoshop to 

process JPEGs and to produce prints with colours 

matching those on the screen, along comes RAW. In this 

issue Mike Quickenden explains recent developments in 

the Camera Raw converter provided by Adobe.  Then 

for digital projection we need to produce our files to 

1024 x 768 pixels and enter text details such as Author 

and Title not possible in the old film days. Stan Searle 

explains his technique for doing this.   

 

More topics created by the digital revolution will need to 

be addressed in future issues.  For example, the ease 

with which thousands of images can be collected makes 

it necessary to consider the problem of efficiently 

organising and searching them. Fortunately, tags and/or 

keywords and other metadata contained within the 

digital image file can be used to automate this process.  

 

Then, just when we are all thinking what will all this 

mean in terms of extra storage (very large hard drives) 

and continuous and expensive updating of software like 

Photoshop, we find that this might all be replaced by the 

concept of „cloud computing‟. Here, we will use the 

internet as our personal computer. Most of the software 
that we need will be on the internet not our computer 

e.g. Google Docs can replace Microsoft Word. Google‟s 

Picasa is just one example of a site with image editing 

facilities and room for storing images.  

 

The rate of development of camera software and image 

processing sophistication has been staggering. How is 

the ordinary amateur to keep up? How many know for 

example that the camera manufacturers issue regular 

updates to correct bugs in or enhance the firmware in 

their cameras. 

 

Within the Club, the gap in expertise has probably never 

been so wide and hopefully we can find ways to close it.  

So more articles like those of Mike and Stan please. 

 

The closing date for the next issue is March 3
rd

 2009. I 
am happy to take longhand but prefer Word documents 

in 10 point Times New Roman. My thanks to 

contributors to this issue and to John Holt and Vaughan 

for proof reading. I must also thank Piers Hemy, way up 

in the Black Isle, north of Inverness, for continuing to be 

our printer. 

 

Martin Nellist   
 

Opening evening  30
th

 September.  
 

On our first meeting of the season we watched a 

projection of the EAF Exhibition Prints and Slides, 
which had been transferred onto CD and then 

commented upon by Colin Southgate, FRPS. We saw 

some really excellent images and heard a commentary to 

match. 

 

Martin Nellist  
 

Photo Eye 1 by Ron Tear ARPS 

MPAGB 

 
On 7

th
 October, Ron Tear gave us what is becoming 

unusual, a 35 mm slide show. The slides covered most 

of his career starting with aviation photography and 
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moving through most types of subject. They were good 

slides but did not stand comparison with digital images. 

They lacked the basic corrections and other 

manipulations which in digital are commonplace and 

which we have come to expect. 

 

The attendance at this meeting was very good with some 

new members and we were especially pleased to see the 

return of Graham and Holly Pumphrey after Graham‟s 

illness. We were also pleased to see three former 

presidents, Kay and Tony Beaumont and Maurice 

Leusby.  

 

This was the first night on which Diana Moss collected 

digital files in advance of the following week‟s 

competition. She also introduced a new entry form. 

 

Martin Nellist  
 

North Norfolk Weekend 
 

Twenty-one members and their partners took part in the 

weekend based on The Lodge at Old Hunstanton from 

10-12 October. We all met for dinner on the Friday and 

Saturday nights but otherwise went our own ways in the 

search for pictures. We were very lucky to have calm, 

sunny weather and Mike Olney had provided a most 

thorough guide to the host of places in easy reach along 

the North Norfolk coast. For Hilary and me the highlight 

was a boat trip out to see the seals at Blakeney point. 

Unfortunately I did not make the most of what was an 
excellent photo-opportunity. I had done just what, in a 

later lecture, Malcolm English warned us not to do. I had 

gone on an important shoot with equipment (my new 

450D) with which I was not sufficiently familiar.  Never 

mind, I did get some good pictures at other less 

demanding locations. Finally the accommodation and 

food at The Lodge at Old Hunstanton were first class 

and all those who were there thank Mike Olney for his 

excellent arrangements. 

 

Martin Nellist  

 

 

Open competition October 14
th

  
 

Colin Southgate FRPS who had 

provided the recorded 

commentary on the opening 

evening was the judge for this 

evening. His comments were 

excellent. Kind but nevertheless 

conveying the weaknesses of 

each picture and explaining why 

a particular image specially 

appealed to him. Even so he was 

admirably brief and managed to 

get through over 50 prints and 

50 digital images in good time. The results were as 

follows:- 

Prints 
1st. Martin Nellist  Menorcan Street 

2nd. Clive Walton  Exhausted after the kill 

3rd. Stanley Searle  Shared Happiness 

H.C Jim Burnett  Mysterious cloisters at  

   Glurns 

H.C. Vaughan Southgate  Chelsea girl 

H.C. David Shepherd  River of Bears 

C. Stanley Searle  Windswept 

C. Helen Shanks  Cornish style on coast path 

C. Tom Yates  South shore, Buttermere  

Projected images 
1st. Tom Yates Drinker Moth  

2nd. Tony Joyce Flying Colours  

3rd. Vaughan Southgate Nevern Estuary 

H.C Peter Weaver Below Stairs  

H.C. Brian Felles Scottish Buskers  

H.C. Peter Weaver Skipton Waterway  

C. Fred Harris Awash on the Tyne  

C. John Pegram Galapagos Sea Lion Pup 
C. Alistair Jones String Quartet  

 

 

Fantastic Falklands by Richard 

Revels FRPS 
 

Bedford Camera Club former member and now 

Bedfordshire‟s foremost nature photographer came to 

talk to us on 21
st
 October. In four visits to the Falkland 

Islands beginning in 2003, Richard has built up an 

impressive array of mainly natural history images. 

However, with his usual attention to detail, he did 

include excellent maps and location photos to explain 

where the natural history images could be obtained. He 

showed us some stunning pictures of everything from 

birds and local plants through to seals and sea lions and 

one killer whale.  The Cara-Cara hawks were beautiful 

birds but on one island they were becoming over 

populated and had virtually wiped out several species, 

especially the herons. Amongst other birds that we saw 

were several types of hawk, a vulture, wrens, bitterns, 

and penguins.  

 

Richard finished with stunning shots of his top five 

species which included three types of penguin. He prints 

his own images and had sold some of the penguin 
pictures at £120 each. He uses Canon EOS 1D Mark 3 

supplemented by an EOS 5D and an EOS 50D. His main 

lens is 400 mm with 2x and 1.4x converters.  The birds 

were so tame, and could be approached so closely, that 

at times even 400 mm was too long.  

 

Martin Nellist  
 

Lectures for second half of season  
 

6
th
 January Dave Stewart  ñPrints that please 

meò 

 

27
th

 January Adrian Stone ñAn American 
Holidayò  

A view of Americans on holiday in the 

Yellowstone area 
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10
th

 February  Membersô evening.  

 

3
rd

 March Darren Marsh   (No title yet) 

 

14
th

 April Liz & Barrie Hatten   ñArctic Sagaò 

A journey to Western Greenland, 

Iceland and the Faeroe Islands. 

 

28
th

 April Roger Hance ñClose-up 

Photographyò 

 

5
th

 May Annual General Meeting 

 

Helen Shanks 
 

Competitions for second half of 

season 
 

2009  

13 January Architects' Association and NALGO 

Competition Wet Architecture & 

Carbon Footprint  Derick Mears 

LRPS 

3 February Open Competition Chris Anderson 

17 February AV Competition Judged by Members 

24 March Competition "Festival"  Derek 
Larkin EFIAP 

21 April Open Competition  John Law FRPS 

MFAIP 

 

Tony Joyce ARPS 

 

Points of View.  
 

 
 

On Sunday 28th October, the day of our points of view 
competition in Cambridge, I awoke at about 06.00 to 

pouring rain. Although, by the time we all met at Trinity 

College, the weather had improved slightly it was still 

drizzling and grey. My biggest worry was that one of the 

subjects was "Colourful Cambridge "! 

 

I gave out the rules, we had a group photograph and we 

all went our separate ways to meet the challenges ahead. 

The six themes were:- 

 

1. A Typical Tourist (No camera club 

members) 

2. Activity on the River 

3. Decorative Mouldings on Buildings 

4. Bicycles or Part of 

5. Colourful Cambridge 

6. Trinity College, inside or outside  

 

The mood of the members was very good and I am sure 

everyone met the challenge of the conditions.  We were 

very well treated by Trinity College staff and although 

we had permission to use tripods some of us (who 

looked too professional!!) had to sign a copyright form. 

We all met up at The Orchard Restaurant in Grantchester 

and discussed the day over tea and cake in which time 

the sun came out in all its glory (too late I'm afraid). 

 

I am sure that everyone had a good time. Don‟t forget 

that the closing date for entries is 25th November with 

the judging by Liz Hatten on 16th December. 

 

Tony Joyce, ARPS 
 

 

Wildlife Photographer of the Year 

2008 
 

On the evening of 

November 5
th
, Marilyn 

and I attended a private 

view of the winning and 
commended entries for the Wildlife Photographer of the 

Year Competition at the Natural History Museum in 

South Kensington. The competition attracted over 

32,000 entries by photographers from 82 countries, the 

rise in numbers being attributed to the increase in 

popularity of digital photography, and 96% of the 

images were in digital format. The coveted title Wildlife 

Photographer of the Year 2008, and first prize of 

£10,000, went to a professional photographer for an 

amazing photograph of a wild snow leopard, but there 

are many other striking and memorable images about 

which most of us only dream.  

 

The exhibition runs in London until Sunday April 26th 

2009 before going on tour to 60 cities around the world. 

I strongly recommend any club member, whether or not 

they have a strong interest in natural history, to visit this 
beautifully presented exhibition. They cannot fail to be 

impressed.  

 

For further information visit www.nhm.ac.uk/wildphoto 

 

Vaughan Southgate
 

 

 óIn Search of the Unusualô   
 

On 28
th

 October we were fortunate that our judge, Peter 

Hrebien CPAGB from Bury St Edmunds, had risen from 

his sickbed to join us. Rightly or wrongly, in the first 

half of the evening he seemed to place more emphasis 

on creativity than on unusual content. Because they were 
unusual he did not always recognise the subjects. 

Examples were the scarecrows from village 

competitions, the reflection of the unusual clock in 

Cambridge High Street, an unusual vehicle in Machu 

http://www.nhm.ac.uk/wildphoto
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Pichu, and a combustion chamber.  It was clear that, in a 

competition like this, devising an informative brief 

caption becomes important. Notwithstanding this 

problem Peter delivered sensible and cogent comments 

and, unusually, made full use of the range in points, 

spanning from 4 to 10 and including ½ points.  

Seventeen authors had each entered three sets of prints 

and the Philip Lepper Memorial Shield was awarded to 

the set gaining the highest aggregate score. 

 

The results were as follows 

   

1st Martin Nellist – 26.5 pts. Patterned beach; Invasion 

of the Purple Jellyfish; Snow on Plum Blossom. 

 

2nd John Pegram – 25.5 pts. Lurking in the shadows; 

Backpackers Express; Down the Hatch. 

 
3rd Clive Walton – 24.5 pts. Too much cheese for 

supper; Beauty on Death ï Illuminated; Ice Breaker on 

Ice ï Antarctica. 

 

Martin Nellist  
 

From Poacher to Gamekeeper by  

Malcolm English  
 

By his own admission Malcolm 

English started out on the road to 

becoming a professional aviation 

photographer and latterly editor of 

Air International magazine while a 

member of Bedford Camera Club 

over 30 years ago. So it was a 

pleasure to welcome him back on 

11
th

 November. 

 

Although presented by digital projection, the images he 

showed us spanned his whole career.  In the first half we 

saw images of all types of aircraft mostly in situations 

such as airports and small airfields such as Duxford and 

Old Warden, where amateurs are able to obtain good 

images.  Malcolm outlined how to decide the best 

vantage points in relation to take off and landing and to 
those parts of the airfield where any special 

demonstrations would mainly take place.  At Old 

Warden for example the planes fly around an L shaped 

field and standing in the knee of the L is a good place to 

catch the planes on their sides as they bank round. 

 

After the tea break we moved onto more specialised 

aerial shots. Malcolm had been along on sorties with 

military aircraft from a number of countries and here the 

shots were beyond what a mere amateur could expect to 

obtain.  Of particular interest was airborne refuelling and  

the difficulties and the differences between the 

respective American and British systems. The talk 

concluded with advice upon how we might all go about 

selling photographs of all sorts. The importance of 

researching the market and noting the type of 

photographs the appropriate magazines and advertising 
outlets are using was stressed. Malcolm felt that chances 

could be improved by accompanying a submission with 

an article, say of around 1000 words, giving the 

background to the pictures. 

 

Alan Woodward gave the vote of thanks and revealed 

that he had obtained a copy of Malcolm‟s book on 

Aviation Photography for the Club raffle.  In response 

Malcolm talked a little about his early years as a Club 

member emphasising what a friendly atmosphere there 

had always been and that senior members of the Club 

were always willing to provide advice and guidance.  In 

conversation later he remembered that his daughter, then 

aged 7, presented the flowers to the Marchioness of 

Tavistock (Lady T of the television series on Woburn 

and now Dowager Duchess of Bedford) when she 

opened our Annual Exhibition. This she did on April 

22
nd

 1976.  I joined the Club in October 1977. 

 

Martin Nellist  
 

Beds Inter Club Competition 
 

Thirteen clubs from an area now 

extending into Hertfordshire and 

out to Milton Keynes took part 

in this event which we hosted at 

the Priory Church on 6
th

 

November. Planning for this 

event started in February and I 

was relieved and pleased that all 

came together perfectly on the 
night with 78 attendees. The 

judge Kate Platt ARPS had 

driven all the way from Worcester and was driving back 

the same night. I feel that she gave a good commentary 

on the images. 

 

The Clubs and their scores were as follows:- 

 

Biggleswade 101 

Shillington    97 

Rushden     92 

Harpenden 91 

Vauxhall     87 

Park Street 87 

New City     86 

Letchworth 84 

St Albans     81 
Kempston  79 

Bedford   77 

Ampthill 76 

Stevenage 67 

 

Bedford‟s entry was  

John Pegram  Eilean Donan Castle 18 

Tony Joyce ARPS On the Grid   14 

Stan Searle APAGB Grows it - Smokes it 13 

Alistair Jones  Quartet   13 

Mike Quickenden Bowing to the Audience 10 

Steve Ridgway LRPS Architectural Reflections 9 
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So Bedford‟s total score was 77 and only gained us a 

disappointing 10
th

 place.  First place went to 

Biggleswade and Shillington were runners-up. The cup 

for the best image was awarded to John Woodworth of 

Park Street for Old Man in Church. 

 

I would like to thank everybody who helped during the 

build up to the competition and assisted on the night. 

 

The next external competition will be the Cambridge 

Digital on 17th January 2009. Also in January we have 

to select 60 images for the EAF competition. 

 

Tony Joyce ARPS 
 

Editorôs Comment. For me Steve Ridgwayôs image 

Architectural Reflections is outstanding and I just could 

not believe that it was only given 9 points, the lowest 
score of the evening. 

 

Biggleswade -Bedford Battle  
 

For the first time since the competition started 

Biggleswade beat us 500 to 461.  The judge was Trevor 

McHugh who gave us good comments and constructive 

criticism. Bedford was represented by 9 members and 4 

members attended on the evening of 13th November. 

 

It was nice to see friendly faces from Biggleswade and I 

presented Dave Smith (President) with the trophy which 

they won at Beds Interclub. 
 

Next year Biggleswade will host this event again. 

 

Projected images 

Tom Yates Common Blues 20 

Terry Mann Up on the roof 18 

Tom Yates Hoar Frost 18 

Tom Yates Drinker Moth 17 

John Pegram Saltwater Crocodile 16 

Tony Joyce ARPS Preening 16 

Stan Searle APAGB  Dignified Lady   15 

Steve Ridgway 

LRPS 

Architectural Reflections 15 

Terry Sykes Manhattan Skyline 15 

Tony Joyce ARPS Flying Colours 14 

Deryck Cutler ARPS 

AFIAP 

Footwork 13 

John Pegram Eilean Donan Castle 13 

Pat Quickenden Opera House, Santa Cruz 12 

Pat Quickenden Volcanic Rocks, Tenerife 11 

Tony Joyce ARPS Classic Design 11 

Total  226 

 

Prints 

Tony Joyce ARPS Snowberry 20 

Tony Joyce ARPS Autumn Avenue  19 

Pat Quickenden The Grand Canyon 18 

Clive Walton Exhausted after the Kill 17 

Tony Joyce ARPS Flower Fantasy 17 

Pat Quickenden Bryce Canyon 17 

John Pegram City of Steel 17 

Martin Nellist Patterned Beach 17 

Jim Burnett Mysterious Cloisters at 
Glums 

15 

Vaughan Southgate Chelsea Girl 14 

Pat Quickenden Let Sleeping Dogs Lie 14 

John Pegram Lonely Giraffe 14 

John Pegram Asian Short Clawed Otter 13 

Martin Nellist Millennium Bridge and St 

Pauls 

12 

Martin Nellist Menorcan Street  12 

Total  235 

 

STOP PRESS 
 

We urgently require 60 quality images (30 print and 30 

digital) for the EAF championship. 

 

Entries must be in by 17th January and they need to be 

with me by 10th January. 

 

Tony Joyce, ARPS 
 

 

Portraiture Workshop  by David Steel 
 
This very useful practical evening was on 18

th
 

November. Using his own studio flash unit, David Steel 

first demonstrated how to set up the background, lights 

and reflector. He then used test exposures on his own 

digital SLR to set a suitable flash power for correct 

exposure at f.8 of Leanne, our first model of the evening. 

Club members could now take pictures using their own 

cameras. Because the flash was triggered by wireless 

remotes which could easily be transferred between 

cameras this was a relatively quick operation and before 
long David had posed Kevin, our male subject, and reset 

the lights to give a harder more masculine effect. The 

evening was completed by a two flash set up for our 

final two models, Phil and Rachel, who were dressed as 

a pearly king and queen. David stressed the importance 

of talking to the model(s) while taking the pictures and 

of supplying prints later as a thank you. He also drew 

our attention to two websites:- 

„www,theCameraclub.org.uk‟ is forum for exchange of 

views and information between photographers. 

„www.gear4sale.org.uk‟ allows registered members to 

buy and sell photographic and computing equipment in a 

simpler manner than on Ebay, for example. Both sites 

are free. 

 

Martin Nellist  
 

BCC year one, 2007-2008. 
 

Like many I have always been interested in 

photography; from using my father‟s Rolliecord at a 

very young age and not understanding why the image 

was upside down, through B & W and colour developing 

and printing, to the digital process and all that that 

entails; from record shots (of which we have hundreds 
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filed away in albums) to those with a greater range of 

photographic genres. 

 

Previous forays into membership of camera clubs 

revealed a world of tacky modelling sessions, whereas 

the aspirational Bedford Camera Club exhibition of 2007 

in the Bedford museum was the starting point of a 

retirement hobby. 

 

To say that the year has been a gentle introduction to the 

world of the amateur photographer would be an 

understatement. With most of the „Photoshop‟ articles in 

magazines making no sense whatsoever and the RPS 

seemingly catering only for the experienced practitioner 

I decided I needed a basic course in photographic 

technique and critique which the OU ably provided over 

a period of 10 weeks. Photoshoots and tuition with 

„Experience Seminars‟ built on those basics and Bedford 
Camera Club has continued to provide a learning 

experience.  

  

     The past year has been really enjoyable and 

informative, not least to discover the esteem in which 

judges are held. I have really appreciated the varied and 

interactive programme in terms of the lectures, 

constructive comments from the judges and of course 

the social events. Long may it continue.  

 

Diana Moss  
 

Digital image sizing 
 

Members will have noticed that this year in our 

competitions we are asked to fill in with black where the 

image does not reach the required dimensions of 1024 

by 768 pixels. In Photoshop CS2 I do this as follows:- 

 

1. Open the image file. 

 

2. In the toolbox set the background colour to black 

 

3. Go to File → Automate Ÿ  Fit image and enter 1024 

width and 768 height. 

 

4. Go to Select Ÿ All and your image should be 

surrounded by marching ants. Click on óCopyô in the 

óEditô menu 

 
5. Go to File Ÿ New  and enter 1024 Width and 768 

Height. Ensure there is a resolution of 300 and the 

„background colour‟ is chosen.  Click on OK 

 

6. Click on Edit  Ÿ Paste. 

7. Select Layer → Flatten image. 

8. To enter the file information select File →File 

information  and type your name on the Authorôs line 

and the title in the Description box 

 

9. Save the new file as a JPEG with a new name. 

 

Stan Searle. 

 

Editorôs comment.  I canôt resist putting my oar in! I use 

Fit image if the size reduction is relatively small but if I 

am reducing a full size image I prefer to use the Image 

ŸImage size route. This enables me to resize using the 

Bicubic sharper recommended for size reduction.  Then 

I fill in with black by selecting Image ŸCanvas size, 

resizing as necessary and selecting black as the fill in 

colour. After saving the renamed image I enter the 

Author and Title information in Adobe Bridge. The only 

advantage of doing this is that it can be done later 

without the image being open. Just personal preference! 

 

 

Adobe CS3 and Camera Profiles for 

Raw File Conversion 
 

Because raw file formats and details are not generic 

across manufacturers, Photoshop‟s „Raw Converter‟ 

automatically uses camera specific profiles to make the 

initial conversion from the raw image file.  It is possible 

to create a profile for your particular camera, but that is 

complicated so we won‟t go into that.  Now Adobe has 

developed some new „beta‟ test profiles which it is 

possible to download and install for CS3.  I have done 

this and found them to be useful for my Canon 10D raw 
files. I believe they will be useful for all Canon users, 

and I suspect the same is true for other makes but I do 

not have the experience to comment. 

 

The way I think of these profiles is to take the film 

analogy.  If you take an image on different slide films 

you get different colour renderings.  For example for a 

landscape image Kodachrome would give more natural 

colours whereas Fuji Velvia colour would be richer 

particularly in the greens. Also for portraits, some films 

were better at producing good skin tones.  Adobe‟s set of 

beta profiles simulate some of the different profiles 

which have been available in the Camera Manufacturer‟s  

own raw converter software.  

 

 
 

If you click on the camera icon in the Adobe raw 

converter you will see a pull down box for camera 

profiles. Until you install the extra profiles you will 

probably only have one choice, ACR 4.4.  After 
installation of the beta profiles the available options are:- 

ACR 4.4 

Adobe Standard beta 1 

Camera Faithful beta 1 

Camera Landscape beta 1 

Camera Portrait  beta 1 

Camera Neutral beta 1 

Camera Standard beta 1 
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By choosing different profiles you can immediately see 

the effect it has on the image and make your choice.  For 

my Canon images, the new ones seem to give more 

contrast and I particularly like the Camera Landscape 

beta 1.  It may not be quite “Velvia” but it is a step in 

that direction! 

 

To install these profiles you must be running CS3, and 

you have first to update your Adobe raw converter to 

Version 4.5.  This can be downloaded with instructions 

on how to set it up from the Adobe website.  In essence 

you have to replace your current raw converter file with 

the new downloaded one.  The beta profiles are 

downloaded from a different location.   A search in 

Google for “Adobe beta profiles” will find the location 

and to download you have to register with Adobe Labs.  

The downloaded file is an executable which when 
executed, installs  the beta profiles for you. 

 

Good luck.  However, if you want further information do 

ask me about it and I will try to help.  

 

Mike Quickenden LRPS 
 

End of an Era!  
 
For disposal, the entire contents of a darkroom including 

a Durst M605 enlarger with two lenses, an electronic 

timer, a Philips colour analyser, a Wotan safe light and 

an assortment of tanks dishes etc. 
 

John Holt. 

 

For Sale. Nikon Speedlight SB28 
 

Reasonably good condition. Designed to integrate with 

the Nikon F90, F90X and F4. Works beautifully with my 

F90X.       £50 ono 

 

Terry Sykes 01234 824867 or sykes@screaming.net 

 

Commercial printing.  
 

Piers Hemy asked me to pass on his recommendation of 

www.dscolourlabs.co.uk for the production of prints 

from uploaded files at remarkable speed and remarkable 

prices. He has regularly uploaded files by midday and 

had the results back in the Black Isle by the next day. In 

August, 18 x12 proper silver prints to ICC profiles were 

costing 99p. I haven‟t used  D S Colour  Labs for prints 

but following Piers‟ recommendation, I did use them to 

scan 227 35mm transparencies onto CD and was happy 

with the results. 

 

Martin Nellist  

 

Photoshop Tips 
 
Use the „Color(sic)‟  blending mode to change the 

colour of an object in an image. Make a selection around 

the object and copy to a new layer. Clear the image 

within the section in the new layer and then EditŸFill 

with the new colour and change the blending mode to 

óColorô. If necessary reduce the opacity of the new 

layer.  

   

Martin Nellist  
 

Camera Club Flash Equipment ï a 

reminder. 
 
The Camera Club owns a set of „Interflash‟ flash 

equipment which is available for any member of the club 

to use.  At present I am using it to practise taking 

portraits.  This information is to let members know the 

whereabouts of the equipment and should you want to 

use it just let me know, and I will get it packed up ready 

for collection. 

 

As an alternative, I thought it may be of interest to some 

members if I make the flash equipment and my studio 

available should they wish to use the equipment without 

having to go through the process of setting it up.  The 

studio is 10ft x 13ft and is secure and private with good 

natural light.  It has both black and white backdrops, 

blackout for windows, a reflector, several different 

chairs for seating arrangements and a table for still life. 

 

Peter Robinson 
I can be contacted on 01525 712809. 

  

Dates for your diary 
 

EAF Club Print Championship 

on 

Sunday 15th February 2009 
 

Latton Bush Centre,Southern Way, Harlow CM18 7BL 

 

This event will find the top Digital Projected Image club 

and Print club in the Federation. It will also select the 

two clubs to represent the Federation at both the 

 

PAGB Inter -Club Digital Projected Image 

Championship 
to be held at he University of Warwick Arts Centre in 

July 2009 
and the 

PAGB Inter-Club Print Championship 
to be held at Connah‟s Quay in October 2009. 

 

Both entry forms and a set of rules went out to club 

Secretaries at the beginning of October. Please read the 

Rules carefully. Prints must be 40cm x 50cm or 16” x 

20”. No other size will be accepted.  

 

Closing date for club entry forms.  

Saturday 10th January 2009 

 

Last date for digital projected images on CD. 

Saturday 17th January 2009 

mailto:sykes@screaming.net
http://www.dscolourlabs.co.uk/
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EAF Competition Secretary - Marilyn Steward ARPS  

DPAGB BPE3* 

 

EAF Slide Event 
 

To be hosted by Bishop's Stortford Camera Club at 

Latton Bush Centre, HARLOW  on SUN. 8th 

MARCH 2009 

 

FEDERATION AGM  
followed after lunch by 

 

Jean Brooks EFIAP 

"WINNERS AND SELLERS" 

Travel images that either sell or win 

 

Mike Wilkes FRPS 
"BRITISH WILDLIFE AUTUMN to SPRING" 

Various Species of Wildlife over the three seasons 
 

Hon. Events Secretary - Naomi M. Saul ARPS, EFIAP, 

DPAGB, APAGB BPE4* 

 
 

Successful LRPS Panel 
 

By the time you read this I expect that some of you will 

know that I was successful in being awarded an LRPS in 

November.   My ten-image panel is printed below in the 

hope that it will encourage other members to try their 
luck.  You will be familiar with most of the pictures, 

(not all of which have been particularly well reviewed 

by Bedford Camera Club judges).  I just chose the ones 

which I liked and which I felt made up a reasonably 

compatible panel.  (The objective for the LRPS is to 

demonstrate a variety of techniques.) 

 

The images were all re-printed on the same type of matt 

paper and mounted in similar white mounts.  Although I 

already had mounted versions of all of them, they were 

in different coloured mounts and on various papers, and 

anyway I wanted to introduce minor improvements for 

most of them.  Thus, there was no possibility of doing it 

on the cheap.   

 

The standard of the other panels was generally very high 

and the judges were quite demanding.  (The most 

common criticism was of over- and under-exposed 

areas, resulting in loss of detail.)  After a long, nail-
biting wait, my panel was judged acceptable, the main 

criticism being that my Super A3 images were rather too 

large for the standard 40 x 50 cm mounts.  There was 

also a remark about „excessive use of the sharpening 

tool‟.  I might agree about the size, but I must protest 

about the „sharpening‟.  (These judges came from the 

same school as ours do!) 

 

All round it has been a worthwhile exercise and I am 

sure that many of our members would qualify.  Why not 

have a go? 

 

Peter Weaver 

 

 

 


